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    Prefácio


    A empresa norte-americana National Instruments (NI) em 1986 iniciou uma verdadeira revolução ao colocar no mercado o LabVIEW, um ambiente de programação gráfica, cuja linguagem foi chamada pela NI de linguagem G.


    No ambiente LabVIEW, ao invés de se desenvolver código textual, usa-se objetos gráficos na forma de ícones, ou blocos funcionais, que interconectados constroem a lógica desejada, e como consequência a linguagem possibilita o desenvolvimento de aplicações mais rapidamente, devido à maior facilidade de implementação e depuração do código. Ao introduzir no mercado uma linguagem com fundamento gráfico, o LabVIEW fundou um paradigma lógico orientado a fluxo de dados.


    O LabVIEW se caracteriza como um ambiente de programação para o desenvolvimento de instrumentos virtuais, sendo, ainda, multiplataforma e com grande suporte de integração com dispositivos de hardware, desde: Portas Seriais, Interface USB, Ethernet, Bluetooth, Câmaras de Vídeo, até dispositivos controladores avançados baseados em plataformas embarcadas e de lógica reconfigurável. Por todas essas razões, desde seu lançamento em 1986, se tornou uma ferramenta de enorme sucesso, e sendo de amplo uso por engenheiros e cientistas, aplicada em projetos de pequeno, médio e grande porte, usada em empresas e instituições como a NASA e o consórcio do acelerador de partículas do CERN.


    Este livro se propõe a apresentar o ambiente LabVIEW de forma prática, com o objetivo de tornar o leitor proficiente no desenvolvimento dos mais variados projetos, em especial na área de aquisição de dados em plataformas embarcadas (NI-myDAQ, NI-myRIO, Arduino, etc.), podendo se constituir em uma boa opção de livro texto em cursos de Engenharia, Tecnologia e Técnicos nas mais variadas áreas, como as de Computação, Elétrica e Eletrônica, Controle e Automação e Mecatrônica Industrial.


    Prof. Eduardo G. Bertogna, Dr. Eng.


    e-mail: ebertogna@gmail.com
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    Visão Geral do LabVIEW


    1.1 O que é LabVIEW


    O nome LabVIEW é o acrônimo para: Laboratory Virtual Instrument Engineering Workbench, sendo um ambiente de programação gráfica desenvolvido pela empresa norte-americana National Instruments em 1986, e, desde então, vem se tornando um padrão em aplicações de engenharia e ciência, contando as seguintes características e possibilidades:


    • Ambiente de programação gráfica orientada a fluxo de dados que usa objetos gráficos na forma de blocos funcionais representados por ícones que interconectados constroem a lógica do programa;


    • Com o LabVIEW é fácil e natural integrar componentes de hardware e software no desenvolvimento de aplicações sofisticadas, aplicadas principalmente nas áreas de testes, medições e controle automático;


    • O LabVIEW possibilita o interfaceamento fácil e rápido com uma ampla gama de dispositivos de hardware, tais como: Porta Serial, Interface USB, Câmara de Vídeo, GPIB, e Placas de Aquisição diversas.


    • Possibilita o desenvolvimento para Sistemas Embarcados e Lógica Reconfigurável, usando os dispositivos da NI para essa finalidade como: o CompactRIO e o myRIO, sendo possível o desenvolvimento para sistemas operacionais diversos, como Windows, Linux e Mac OS X, como mostra a Figura 1.1;


    • Oferece uma grande variedade de bibliotecas de ferramentas prontas na forma de blocos funcionais que facilitam no desenvolvimento das aplicações, reduzindo o tempo de desenvolvimento, aumentando a confiabilidade e a flexibilidade, sendo por isto usada por empresas e centros de pesquisa do mundo todo, desde aquelas de pequeno porte, até gigantes como a NASA e o CERN;


    • Completa biblioteca de componentes para realizar análises que ajudam a extrair informações de dados brutos, além de bibliotecas para processamento de sinais e imagem, projeto e simulação de sistemas de controle, matemática e estatística, comunicação de dados e conectividade, dentre muitas outras.


    
      [image: ]
    

    Figura 1.1: Integração LabVIEW com HW e SW diversos.


    1.2 O que é um Instrumento Virtual


    Os programas desenvolvidos no ambiente LabVIEW recebem o nome de Instrumentos Virtuais (no idioma inglês: Virtual Instruments, com sigla: VI), nome este derivado do fato de um VI imitar instrumentos físicos reais, tais como osciloscópios, dispositivos multimídia, etc. Estes VIs desenvolvidos com o LabVIEW podem ser extremamente poderosos e sofisticados com interfaces gráficas elegantes e inúmeras funcionalidades. VIs customizados com variados tipos de controles e indicadores podem ser desenvolvidos para uma aplicação específica, em especial em aplicações de testes, medições e controle.


    Na Figura 1.2, a seguir, estão mostrados alguns Instrumentos Virtuais criados com o LabVIEW.


    
      [image: ]
    

    Figura 1.2: Exemplos de Instrumentos Virtuais. Acima Osciloscópio, abaixo Analisador de Sinais Dinâmicos.


    Na Figura 1.3 é mostrado um VI para um sistema de aquisição de dados de emissões de fótons, desenvolvido para pesquisas em Biofotônica.
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    Figura 1.3: Exemplo de um Instrumento Virtual (VI).


    E na Figura 1.4, parte do código do VI acima, na linguagem de programação gráfica do LabVIEW, a linguagem G.


    
      [image: ]
    

    Figura 1.4: Diagrama em Blocos do VI da Figura acima.
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    Apresentação do Ambiente LabVIEW


    O ambiente LabVIEW é composto pelo Project Explorer onde o projeto é gerenciado e definido, do Front Panel, do Block Diagram, além do Help do LabVIEW, que pode ser evocado a qualquer instante que haja necessidade. Estes 4 elementos do ambiente LabVIEW podem ser vistos na Figura 2.2. A cada VI em LabVIEW estará associado um Painel Frontal (Front Panel), onde é definida a interface com o usuário, e seu Diagrama em Blocos (Block Diagram), onde o código é definido, como pode ser visto na Figura 2.2. Em execução, apenas o Painel Frontal e visível ao usuário, como seria de se esperar, como na Figura 1.3.
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    Figura 2.1: Principais componentes do ambiente LabVIEW.


    
      [image: ]
    

    Figura 2.2: Elementos de um VI no LabVIEW.


    2.1 Criando um novo projeto


    Ao se iniciar o LabVIEW, a seguinte janela, mostrada na Figura 2.3, é apresentada. Nesta janela, as duas opções principais oferecidas permitem: criar um novo projeto em Create Project, ou abrir um projeto já existente em Open Existing.


    
      [image: ]
    

    Figura 2.3: Abrindo ou criando um novo projeto no LabVIEW.


    Ao se clicar em Create Project, a janela mostrada na Figura 2.4 aparece, e nesta a opção: Bank Project é automaticamente selecionada, a qual permite iniciar com um projeto vazio.


    
      [image: ]
    

    Figura 2.4: Criando um projeto vazio.


    Dentre as opções na janela da Figura 2.4, as principais são: criação de um novo VI vazio - Blank VI, sem a criação do projeto; opção de criação de uma estrutura em Máquina de Estados - Simple State Machine; e criação de programa para Medição Contínua e Armazenamento - Continuous Measurement and Logging; sendo as demais opções mais específicas detalhadas mais adiante.


    Para a criação de um projeto vazio deve, então, clicar em Finish, e assim a janela do Project Explorer será apresentada, como mostra a Figura 2.5. No Project Explorer é onde a criação do projeto tem início, e é onde os arquivos deste são organizados e gerenciados.


    
      [image: ]
    

    Figura 2.5: Projeto vazio criado.


    Para adicionar um VI vazio ao projeto, deve-se selecionar: Project=>Add To Project=>New VI, como na Figura 2.6.
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    Figura 2.6: Adicionando um VI vazio ao projeto no Project Explorer.


    Uma vez criado, o VI vazio apresenta a janela do Project Explorer e as janelas do Painel Frontal e do Diagrama em Blocos, ambos vazios, como visto na Figura 2.7.
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    Figura 2.7: VI vazio criado e adicionado ao projeto.


    Em seguida, ao se clicar na janela: Front Panel, em: File=>Save, deve-se atribuir um nome ao VI criado, ver Figura 2.8.
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    Figura 2.8: Atribuindo um nome ao novo VI.
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    Figura 2.9: Atribuindo o nome media_desv_padrão ao novo VI.


    Importante salientar que no Project Explorer uma referência ao arquivo é colocada, e não o arquivo de fato, então, na Figura 2.10, pode-se notar o nome atribuído ao VI na lista de itens do projeto, e também atribuídos as janela do Front Panel e do Block Diagram.
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    Figura 2.10: Referência ao arquivo media_desv_padrão.vi.


    Em seguida deve se salvar o projeto em: Project=>File=>Save, e atribuir um nome ao projeto criado, ver Figuras 2.11 e 2.12.
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    Figura 2.11: Atribuindo um nome ao novo projeto.
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    Figura 2.12: Atribuindo o nome media_desv_padrão ao novo projeto.


    Se o arquivo do VI em disco for deletado, ou sua localização alterada, na referência do Project Explorer continua existindo a relação com a nova posição, 2.13.
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    Figura 2.13: Localização do arquivo do VI no disco.


    Ao se remover no Project Explorer o arquivo “media_desv_padrão.vi”, ele somente será removido do projeto, permanecendo no disco onde foi salvo, uma vez que no Project Explorer este é apenas uma referência ao arquivo.
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    Figura 2.14: Removendo uma referência de um projeto.


    Uma mensagem de confirmação é apresentada quando da remoção da referência do arquivo, ver Figura 2.15.
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    Figura 2.15: Confirmação de remoção pedida.


    No entento, após a remoção de um item, no disco onde o VI foi salvo, este arquivo ainda permanece sem ser deletado.
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    Figura 2.16: Presença do arquivo no disco associado à referência removida no Project Explorer.


    Ao se abrir um arquivo do tipo LabVIEW Project (extensão: .lvproj), o Project Explorer é aberto, e os arquivos associados ao projeto mostrados na janela deste, como o media_desv_padrão.vi, ver Figura 2.17.
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    Figura 2.17: Abrindo um arquivo de projeto .lvproj.


    2.2 Gerenciamento do Projeto


    Adicionando uma Pasta tipo Auto-Populating


    Podem-se adicionar pastas de arquivos ao projeto, de modo a se criar uma estrutura de arquivos organizada, e uma das opções possíveis é a pasta do tipo Auto-populating, que leva esse nome por ser continuamente atualizada quando itens desta são adicionados ou removidos.


    A Figura 2.18 mostra como se pode adicionar uma pasta do tipo Auto-populating ao projeto.
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    Figura 2.18: Adicionando uma pasta do tipo Auto-populating.


    Então, a pasta escolhida é adicionada ao projeto, e sendo do tipo Auto-populating seu conteudo no Project Explorer é atualizada sempre que algum arquivo desta é adicionado ou deletado, ver Figura 2.19.
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    Figura 2.19: Adicionado-se um Auto-populating Folder ao projeto.


    Então, ao se deslocar arquivos para o Auto-populating Folder, no Project Explorer estes aparecerão como mostrado na Figura 2.20.
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    Figura 2.20: Arquivos movidos ao Auto-populating Folder.


    Adicionando uma Pasta tipo Virtual Folder


    Um Virtual Folder é um tipo de pasta organizacional, pois não representa arquivos no disco, mas referências a estes. Para adicionar um Virtual Folder ao projeto, no drop-down menu selecionar: New => Virtual Folder, e digitar um nome a este, por exemplo: “Estatistica”, ver Figuras 2.21 e 2.22.
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    Figura 2.21: Adicionando um Virtual Folder ao projeto.
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    Figura 2.22: Nomeando o Virtual Folder.


    Pode-se converter um Virtual Folder em Auto-populating Folder, através do drop-down menu que se apresenta ao clicar com o botão direito do mouse sobre o Virtual Folder que se deseja converter, escolher a opção: Convert to Auto-populating Folder, como mostrado na Figura 2.23.
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    Figura 2.23: Convertendo um Virtual Folder em Auto-populating Folder.


    Discutiu-se até aqui os itens do Project Explorer na aba Items. Na aba Files, os arquivos são referidos na sua localização em disco.
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    Figura 2.24: Aba Files do Project Explorer.


    No Project Explorer, pode-se fazer mais que simplesmente gerenciar arquivos do projeto, pode-se ainda:


    • Criar Projetos de Sistemas Embarcados Remotos como dispositivos de hardware (como: CompactRI0, ou myRIO, etc.);


    • Criar executáveis e instadores para distribuição aos usuários;


    • Criar bibliotecas compartilhadas (Dynamic Linked Libray - DLL);


    • Distribuir código entre desenvolvedores e integrar o LV com aplicativos de Controle de Versão e Fontes, como o Perforce.


    2.3 O Painel Frontal do LabVIEW


    Como já mencionado, é no Painel Frontal (Front Panel) do VI onde se define a interface com o usuário, constituída de Controles e Indicadores. Controles são elementos para entrada de informações, e Indicadores são os de saída de informações. Os Controles e/ou Indicadores podem ser de vários tipos, dentre eles: Numéricos, Dials, Slides e Gráficos.


    2.3.1 Adicionando Controles/Indicadores no Painel Frontal do VI


    Quando se clicar com o botão direito do mouse no Front Panel aparecerá a janela de palettes de controles, o Controls Palette, como mostrado na Figura 2.25. Nestes palettes pode-se escolher os elementos que irão compor a interface com o usuário, dentre uma grande variedade de controles e indicadores, representando variados tipos de entradas e saídas de dados, tais como: numéricos, booleanos, gráficos, enumerados, strings, matrizes, vetores, dispositivos de hardware, elementos decorativos, dentre outras inúmeras possibilidades oferecidas, que serão apresentadas ao longo dos demais capítulos e seções deste livro.


    Uma vez que o controle ou indicador tenha sido selecionado de um subpalette, este poderá ser colocado no Painel Frontal, escolhendo-se a posição mais adequada a este, e clicando-se novamente com o botão esquerdo do mouse.


    Na Figura 2.26, alguns exemplos de controles e indicadores são mostrados.
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    Figura 2.25: Palettes de controles mostrados no Painel Frontal.
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    Figura 2.26: Vários tipos de controles e indicadores numéricos.


    Os controles e indicadores disponíveis para uso no Painel Frontal são apresentados no Controls Palette em 4 estilos diferentes, em 4 subpalettes, a saber: Modern, Classic, System e Silver, sendo que na Figura 2.25 o estilo Silver está sendo mostrado, e na Figura 2.27, este mesmo subpalette Numeric, mostrados nos estilos Modern, Classic e System.


    Observar nesta Figura 2.27 que nem todos os controles e indicadores de um subpalette tem seus correspondentes nos outros subpalettes.
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    Figura 2.27: Subpalette de controles do tipo Numeric no estilo Modern, Classic e System.


    Pode-se mudar os palettes que estarão visíveis na evocação do Controls Palette, selecionando-se: Change Visible Palettes, como mostrado na Figura 2.28, e então, na janela de seleção que aparecerá em seguida, selecionar os palettes que serão mais usados pelo desenvolvedor dos VIs.
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    Figura 2.28: Seleção de palettes que serão visíveis.


    Cabe salientar que, no Diagrama em Blocos, associado a um Painel Frontal, há a contrapartida do Controls Palette, que se chama: Functions Palette, onde os blocos de funções que constituem a linguagem gráfica do LabVIEW estão organizados em palettes e subpalettes, e o procedimento para se selecionar os que estarão visíveis segue este mesmo procedimento descrito no parágrafo anterior.


    2.3.2 A Barra de Ferramentas do Painel Frontal


    A barra de ferramentas do Painel Frontal, quando o VI não está em execução, é mostrada na Figura 2.29, cujas ferramentas são descritas a seguir.
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    Figura 2.29: Barra de Ferramentas realçada no Front Panel.


    • Botões de Execução: Run [image: ], Run Continuously [image: ], Abort Execution [image: ] e Pause Execution [image: ]; conforme descritos a seguir:


    - Run: executa o VI uma vez apenas, sendo permitido terminar a execução por um controle do Painel Frontal, ou pelo botão Abort Execution;


    - Run Continuously : executa o VI continuamente, não sendo permitido terminar a execução senão pelo botão Abort Execution;


    - Abort Execution: termina a execução do VI imediatamente;


    - Pause Execution: permite pausar a execução do VI imediatamente.


    • Botões de Edição: Text Settings [image: ], Align Object [image: ], Distribute Objects [image: ], Resize Objects [image: ] e Reorder [image: ]; conforme descritos a seguir:


    - Text Settings: permitem editar o tipo, tamanho e cor das fontes, a nível de Aplicação, Caixas de Dialogo, e de Sistema, ver Figura 2.30;


    - Align Objects: usado para ajustar o alinhamento de objetos do Painel Frontal, distribuição e tamanho de objetos, e reorganizar espacialmente os objetos do Painel Frontal, respectivamente, ver Figura 2.31, que mostra as várias opções de alinhamento de objetos.
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    Figura 2.30: Ferramentas Text Editting.
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    Figura 2.31: Ferramenta Align Objects.


    
      [image: ]
    

    Figura 2.32: Alinhando controles em um Painel Frontal.


    • Botão de Ajuda: Help [image: ], permite evocar o menu de contexto, no qual, ao se posicionar o cursor sobre um item, a ajuda para esse item aparece na janela de Context Help, ver Figura 2.33.
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    Figura 2.33: Ferramenta Context Help.


    • Botão de Pesquisa: Search [image: ], retorna resultados do sistema de ajuda, e do site: ni.com/zone na internet, ver Figura 2.34, onde um dos resultados da procura foi escolhido e a janela de ajuda aparece com a descrição detalhada do termo pesquisado.
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    Figura 2.34: Ferramenta Search mostrando resultados obtidos.


    2.3.3 VI em Execução


    Ao se acionar o botão Run [image: ], o VI entra em execução, e seu Painel Frontal aparecerá como mostrado na Figura 2.35 (a), onde um VI muito simples para cálculo da média e desvio padrão de N inteiros é mostrado.


    Quando em execução, a barra de ferramentas apresentará apenas os botões de execução: [image: ], com o botão Run de aspecto diferente, além do botão de ajuda. Neste caso, a execução do VI poderá ser terminada pelo botão Stop do Painel Frontal, ou pelo botão [image: ] da barra de execução. No caso do término do VI via botão [image: ], se algum dispositivo de hardware estiver sendo controlado, e este não for adequadamente finalizado, problemas podem ocorrer com este dispositivo, então, nestes casos, o uso deste botão deve ser evitado.


    Se o botão Run Continuously [image: ] for acionado, este terá seu aspecto mudado para: [image: ], e o VI executa continuamente, ou seja, o término da execução só pode ocorrer através do botão [image: ] da barra de execução, sendo que o botão Stop do Painel Frontal não terá função.


    Se o botão Pause Execution [image: ] for acionado, este também mudará seu aspecto para [image: ], e o Diagrama em Blocos aparece com a execução pausada, ver Figura 2.35 (b).


    
      [image: ]
    

    Figura 2.35: VI em execução (a), e VI pausada (b).


    2.3.4 VI com Erros de Construção


    Quando um VI contiver erros de construção, este não poderá ser executado, e o botão Run se apresentará com a aparência de um ícone quebrado: [image: ]. Por conseguinte, ao se clicar neste botão, o VI não executará, e uma janela de erros aparecerá com as descrições dos erros, como mostra a Figura 2.36. Enquanto todos estes erros não forem solucionados, o VI não poderá ser executado.


    Nesta Figura 2.36, o Diagrama em Blocos ali mostrado apresenta dois blocos de função com entradas não conectadas, que são: o bloco de soma - Add, e o bloco de temporização - Wait(ms), além do botão de finalização do laço While-Loop (ver item 3.3.1), que também está sem conexão.


    Para se localizar um destes erros no Diagrama em Blocos, bastará um duplo clique na linha da lista onde erro aparece, ou clicar em Show Error, e o elemento contendo erro começará a piscar no Diagrama em Blocos. Observe os detalhes do erro selecionado na lista, sendo mostrado no campo Details da janela de erros.


    
      [image: ]
    

    Figura 2.36: Janela de lista de erros quando um Diagrama em Blocos apresenta erros de construção.


    2.3.5 Aparência do VI em Execução


    Pode-se selecionar a aparência que a janela do VI irá assumir quando em execução através da evocação da opção VI Properties, em: File=>VI Properties, na categoria: Window Appearance, como mostra a Figura 2.37. Nesta Figura 2.38, as 3 aparências que se podem selecionar para um VI em execução: (a) Top-Level Application; (b) Dialog; (c) Default. Na opção: Custom, deve-se clicar em Customize para selecionar as várias opções, como na Figura 2.39.


    
      [image: ]
    

    Figura 2.37: Aparência de caixa de diálogo ao VI.
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    Figura 2.38: Aparências de um VI. Em (a) Top-Level Application, em (b) Dialog, e em (c) Default .
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    Figura 2.39: Customizando-se a aparência de um VI.


    Através da caixa de diálogo VI Properties, pode-se, ainda, determinar a posição do VI na tela quando em execução, seu tamanho mínimo, e se este tamanho sofrerá ajuste em diferentes resoluções de tela, ver Figura 2.40.


    
      [image: ]
    

    Figura 2.40: Seleção da posição do VI em execução.


    2.4 O Diagrama em Blocos do LabVIEW


    Pode-se comutar do Painel Frontal para o Diagram em Blocos em: Window => Show Block Diagram, ou via teclas de atalho: Ctrl+E.


    E no Diagrama em Blocos (Block Diagram) onde o código do VI é definido, sendo esse código construído através de representações gráficas, usando a linguagem gráfica G, linguagem esta constituída de 5 tipos básicos de objetos, mostrados na Figura 2.41, e detalhados a seguir.
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    Figura 2.41: Componentes básicos do Diagrama em Blocos e suas relações com os objetos do Painel Frontal.


    2.4.1 Componentes Básicos de um Diagrama em Blocos


    • Terminals: são as portas de entrada e saída que possibilitam a troca de informações entre o Block Diagram e o Front Panel. Estes terminais poderão aparecer como ícones, ou em representações gráficas mais compactas, como estão sendo mostrados na Figura 2.41. Pode-se mudar para a representação por ícones com o botão direito do mouse evocando o menu e mudando em: View As Icon;


    • Function Nodes: são objetos do Block Diagram que possuem entradas e/ou saídas, e executam operações quando o VI está sendo executado, sendo identificados pela sua cor amarelo claro. Os Function Nodes podem ser acessados no Functions Palette, ao se clicar com o botão direito do mouse sobre o Block Diagram.


    • Wires: são linhas que transferem dados entre os objetos do Block Diagram. Estas linhas podem ter diferentes estilos e cores para representar diferentes tipos de dados, tais como números, strings de caracteres, vetores, matrizes, etc.;


    • SubVIs: são VIs executadas dentro de um Block Diagram de um VI, e possuem seu próprio Front Panel e Block Diagram. Os SubVIs aparecem com seus ícones personalizados, e para abri-los e mostrar seu Block Diagram e Front Panel, basta um duplo clique do mouse sobre seu ícone. Todo e qualquer VI tem o potencial de ser usado como um SubVI.


    • ExpressVIs: são um tipo especial de SubVI, aparecendo no Block Diagram como um ícone dentro de uma caixa azul
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    2.4.2 Adicionando Funções/SubVIs ao Diagrama em Blocos
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    2.4.3 Barra de Ferramentas do Diagrama em Blocos
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    2.4.4 Modos de Visualização de ícones e Nó Expansível
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    2.4.5 Usando Wires
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    2.4.6 Usando Labels


    

    

    2.5 SubVIs


    

    

    2.5.1 Criando um SubVI
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    2.6 Criando um Executável LabVIEW


    

    

    
      [image: ]
    

    

    

    

    
      [image: ]
    

    

    

    
      [image: ]
    

    

    
  


  
    Referências


    [1] https://datasheets.maximintegrated.com/en/ds/DS18B20.pdf


    [2] Especificações do Módulo DAQ NI-USB6008, acessado em: https://www.ni.com/pdf/manuals/375295c.pdf


    [3] Guia do Usuário do Módulo DAQ NI-USB6008, acessado em: https://www.ni.com/pdf/manuals/371303n.pdf


    [4] Especificações do Módulo DAQ NI-myDAQ, acessado em: https://www.ni.com/pdf/manuals/373061g.pdf


    [5] Guia do Usuário do Módulo DAQ NI-myDAQ, acessado em: https://www.ni.com/pdf/manuals/373060g.pdf


    [6] Comparing Common File I/O and Data Storage Approaches, acessado em: https://www.ni.com/pt-br/innovations/white- papers/09/comparing-common-file-i-o-and-data-storage-approaches.html


    [7] TDM Add-In Tool for OpenOffice.org Calc User Guide. https://www.ni.com/pt-br/support/documentation/supplemental/07/tdm-add-in-tool-for-openoffice-org-calc-user-guide.html


    [8] Redes de Computadores, 2ª Edição. Gabriel Torres, Editora Clube do Hardware. ISBN: 978-85-52971-00-9


    [9] NI myRIO-1900 User Guide and Specifications, acessado em: https://www.ni.com/pdf/manuals/376047c.pdf


    [10] NI myRIO Quick Start for LabVIEW Users, acessado em: https://www.ni.com/pdf/manuals/376046b.pdf

  


  
    Sites na Internet


    • Site da National Instruments:


    https://www.ni.com/pt-br.html
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    Glossário


    A/D Conversor de Analógico para Digital. ADC O mesmo que conversor A/D.


    AND Operador/Bloco Lógico que executa uma operação E lógica entre suas entradas.


    ASCII Sigla em Inglês para American Standard Code for Information Interghange, que é o código padrão para textos simples, sem formatação.


    CI Sigla para Circuito Integrado, no idioma inglês aparece como IC, de Integrated Circuit.


    Clock Sinal de Relógio usado pelo Microcontrolador/Microprocessador para sincronizar as suas operações internas.


    CMOS Tecnologia de implementação de circuitos lógicos digitais que utiliza transistores MOS, cujo semicondutor utilizado é do tipo Metal-Oxido, tendo como principal característica serem de baixo consumo.


    CPU No idioma inglês: Central Processing Unit. Em português: Unidade Central de Processamento, sinônimo para microprocessador.


    Debug Depuração de um programa.


    GND Sigla para Ground, no idioma inglês. Em português: Referência de Terra.


    I2C Sigla para Inter IC, é um tipo de comunicação serial a dois fios inventada pela Philips.


    IDE No idioma inglês: Integrated Development Environment. Em português: Ambiente de Desenvolvimento Integrado, onde vários programas utilizados em algum tipo de desenvolvimento está integrado em uma única interface gráfica de programa.


    LED No idioma inglês: Light Emmiting Diode. Em português: Diodo Emissor de Luz.


    PWM No idioma inglês: Pulse Width Modulator. Em português: Modulador por Largura de Pulso, o qual é capaz de modular a largura de pulso de um sinal, sem alterar o período o pulso.


    RESET Operação de inicialização dos registros, e circuitos internos do microcontrolador/microprocessador.


    RS-232 No idioma inglês: Recommended Standard 232. Tipo de Comunicação Serial padronizado pela Electronics Industry Association - EIA, no seu Padrão Recomendado 232, introduzido em 1962.


    RTC Sigla para Real Time Clock, no idioma inglês. Em português fica: Relógio de Tempo Real.


    TTL Tecnologia de integração de circuitos lógicos digitais que utiliza transistores bipolar na sua implementação.


    UART No idioma inglês: Universal Assyncronous Receiver/Transmitter. Em português: Receptor/Transmissor Universal Assíncrono, dispositivo de comunicação serial que implementa o protocolo de comunicação assíncrona.
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